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1.1  ScanStudio HD 1.3
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1.2  QA-Scan






QA-Scan 1.0.0 is now available for purchase at https://www.nextengine.com/store



Download Here: ->



Interested in a 15-day trial of QA-Scan?  Contact info@nextengine.com to get started with your 15-
day trial key.



QA-Scan is the ideal solution for inspecting parts with a NextEngine 3D scanner. It borrows a
powerful concept from the CAD world: every inspection job generates a history tree, so you can easily
modify or repeat the inspection process any time. QA Scan is based on RapidForms XOV software
and combines in-depth inspection functionality with highly accurate algorithms certified and tested by
leading metrology labs. 



The Most CAD Friendly Point-cloud Inspection Software

With QA Scan, CAD parts can be imported via Parasolid, STP, or IGS, and QA Scan will
automatically detect features and allow you to quickly define dimensions and tolerances to be
inspected.



Macro-free Inspection Process Automation

In QA Scan, you've got a simple interface similar to popular CAD applications, so running through the
inspection process is a breeze. Just import the CAD nominal, open the scans of your part and you're
ready to go. Every alignment, deviation color map, dimension and tolerance that you measure is added
to the history tree, so you can track exactly what you've done and change anything at any time. No
other point cloud metrology software lets you tweak your inspection process so easily. Imagine that
you're finishing up an inspection job, only to notice your part isn't properly aligned to the CAD model
 no problem! With QA Scan, you simply change the alignment, and the software recalculates every
measurement and regenerates an inspection report.



Powerful Capabilities for the Most Demanding Applications

There's a reason QA Scan is used by almost every major automaker and thousands of other
companies: it has in-depth functionality to complete the toughest inspection jobs. Sophisticated
alignments, ANSI Y14.5b compliant GD&T and extensive deviation analysis capabilities let you
perform detailed inspections of your parts. Sheet metal, castings, plastics, tooling and machined parts
can all be measured and compared to CAD models in QA Scan.



Automatic Inspection Repetition

Because QA Scan tracks every step of the inspection process, once you've inspected one sample of a
part, every subsequent sample can be inspected automatically. QA Scan recognizes features in the scan
data and measures them on the fly without any user interaction needed. So the next part you inspect is
just one step from beginning to end. You don't need to write macros to automate your work because
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QA Scan is history-based just like RapidWorks.



Proven Accuracy, Super Speed and Huge Data Capacity

When it comes to inspection, every calculation counts. That's why QA Scan's geometry calculation
algorithms have been tested by America's NIST, Britian's NPL and independently certified by
Germany's PTB metrology authority as Class 1 accuracy. Top manufacturers around the world trust
QA Scan to measure thousands of parts every day.




4 of 162



1.3  MultiDrive





Setup



 MULTIDRIVE SETUP 



-Here are the items that are included with the MultiDrive




Allen wrench and L Bracket AutoPostioner



-Attach the L Bracket to the MultiDrive with two flat head screws and allen wrench






-Attach the MultiDrive to the bottom of the scanner and fasten a screw underneath the scanner for
additional stability
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-Plug in the MultiDrive to the scanner






-Start ScanStudioHD and proceed to Calibration





Calibration



CALIBRATING THE MULTIDRIVE




Starting first scan with MultiDrive



-"Start" to begin the automated calibration process (We suggesting using the palm tree included with
the MultiDrive)

-"Skip" if you wish to proceed to the scan panel and choose 

-"Learn More" to be directed to this help page.
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You can



-This function is available for re-calibration when alignment results in an error or when the MultiDrive
was detached and is reattached.





Scan Process



SCANNING PROCESS




After calibration is

A new scan panel will be loaded when



-Five families are now available for predefined settings for Positioning, Divisions, Start Angle, Tilt
Angle, Points/IN^2 and Target 

-Clicking on the family name will enable the tab to edit the settings.

-To enable or disable a family, simply check or uncheck the circle next to the family name.

-Starting positions can be set for both the initial and tilt axis by moving the slider bar arrow.

-The start axis has the full 360 rotation and tilt axis is bounded to -35 to 45 degrees.

-Use the top slider bars to visually set the starting and tilt positions. (This will update the settings for
the scan family)
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-Select the scan settings for each tab and check the tabs you want to have scan. 

If the setting for a tab have been adjusted, but the tab is not checked it will not scan.






-All MultiDrive scans are to be in MACRO mode.

-Select a ROI for your model to prevent the MultiDrive from being scanned in for certain tilt angles.

-If additional scans are needed, enter scan panel and position the model by using different starting and
tilt angles to capture additional scans. 

-If you physically adjust the part, then a 3 pin alignment will be needed to align.

-When finished, trim unnecessary data and "Fuse" or "Volume Merge" the model for export: ->





Troubleshooting



ADDITIONAL TIPS AND TOOLS



Warning

- Do not use the AutoDrive PartGripper with the MultiDrive as the length of the pole will cause it to
hit the scanner when the MultiDrive is positioned at certain angles.



Switching between AutoDrive and MultiDrive 

- Simply plug in an AutoDrive to display the proper UI. 

- When reattaching the MultiDrive, make sure to recalibrate as needed.
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- When more than 5 Scan families are required, then just click on scan to enter the scan panel, and you
can add 5 more new sessions. These scans should auto align to the previous scans assuming all the
movement and rotations were done by the turntable. If they don't auto-align , just drag the scans into
the green and refine (no pins required)



- Force Calibration. If your scans are not coming in aligned, you may need to run a force calibration.
You can do this from the drop down menu , Align, then go down to Calibrate MultiDrive





Dental



DENTAL



Recommended Scan Settings for Dental Cast Models




Family A Divisions: 6  Tilt: -10
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Family B Divisions: 6  Tilt: 45 degrees



-Use the HD speed for higher resolution
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Chapter 2



 Installation
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2.1  System Requirements





PC



The 3D Scanner HD is a high resolution device, and quickly captures many millions of points and
pixels.  A powerful PC is key for being able to visualize and take full advantage of this data.






Note:

If you are going to be scanning large or complex models, we highly recommend running a 64bit OS
and upgrading your RAM to at least 4 GB.



For a fast viewing experience, a good graphics card is essential.  In our testing we've found that not all
GPU's are optimized for dealing with lots of points and pixels.



Quick tip for a new Graphics Card:  The latest and greatest is the nVidia GeForce GTS/GTX series.
They are well priced and can handle large amounts of scan data smoothly. The GeForce GTS/GTX
series is available on Newegg with a price range of $115 to $300.



High-end systems need sufficient power to run properly.  If you are seeing errors in ScanStudio HD, it
maybe related to an under specified power supply.  A 600+ watt power supply is recommended to run
high-end systems like those with Intel Core i7 processors.



If you have questions about your system configuration, we'd be happy to help.  Please note the SD
scanner is only compatible with Windows XP and Vista when you are running as the administrator.
All software developed after ScanStudio CORE is only for HD scanners. If you would like to upgrade
your SD scanner please contact NextEngine at info@nextengine.com.



Please click "Ask?" to talk to us about it.





USB



The scanner requires a USB 2.0 connection.



Here's how to check if you have USB 2.0 support, which is required to run the Desktop 3D Scanner.

- Right-click My Computer

- Click on Properties

- Click on the Hardware tab

- Click on the device Manager button
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- Scroll down as needed until you see Universal Serial Bus Controllers

- Expand that by clicking on the boxed plus sign in front of Universal Serial Bus Controllers






If it says "Standard Enhanced PCI to USB Host Controller" it is 2.0. If it does not say "Enhanced" it's
USB 1.0.





PC Buying Guide



It's now possible to purchase a PC with great scanning, CAD, and graphics performance for under
$1000.



We've found that the best combo in terms of price / performance is to assemble the computer from
scratch, purchasing individual parts. For a ready made PC, options such as Dell and HP will let you
choose individual components to meet your needs.



Some tips are provided below for finding the best deals (as of November 2009).  We don't have a
relationship with any of these vendors, but this is how we buy most of our test hardware.



Go to Newegg.com and check out their latest deals.  



Look for a Intel Core2 Quad Processor.  These are the some of the best processors currently available,
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and are dropping in price significantly.  



   Intel Core2 Quad Q9400 - 2.66GHz 6MB L2 Cache - LGA 775 95W 

   Price: $190

   http://www.newegg.com/Product/Product.aspx?Item=N82E16819115131





Upgrading the RAM:



For stable performance when capturing complete models, 4 GB of RAM is recommended.  One
example:



   4 GB DDR2 PC2-8500 RAM 

   Price: $89

   http://www.newegg.com/Product/Product.aspx?Item=N82E16820231166&cm_sp=DailyDeal-_-20-
231-166-_-Product







Upgrading the Graphics Card:



We've found that the nVidia GeForce GTS/GTX series are well priced and can handle large amounts
of scan data.  We've also found that SolidWorks and other CAD programs work quite well with these
cards.  Here's a well priced sample from Newegg.com



   nVidia GeForce GTS 250 - 1GB of RAM 

   Price: $150 

   http://www.newegg.com/Product/Product.aspx?Item=N82E16814150439



  **Make sure to download the latest driver for your Operating System**



The ATI FireGL cards are also recommended.  They have great price/performance.   We do not
typically recommend purchasing a nVidia Quadro for this application.  This is because only the high-
end Quadro models have sufficient processing power to handle large numbers of 3D vertices.





Supported Operating Systems



ScanStudio HD 1.3 runs on Windows x64 operating systems, including the new Windows 7 x64.



ScanStudio HD 1.3 offers a full 64 bit application.



ScanStudio CORE with the SD scanner is only compatible with Windows XP, Vista (with
administrator rights) as well as Windows 7 32/64-bit under special installation instructions.

    Installation instructions for ScanStudio CORE with Windows 7 32 and 64-bit can be found here: 

        32-bit: ->

        64-bit: ->
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2.2  Software Installation





Download



Please uninstall 1.7.3 before installing ScanStudio HD.



- Go the ScanStudio Quick Start Page at http://www.nextengine.com/start



Link to the Download for ScanStudio HD 1.3.0 ->




 Enter your e-mail address and password



- You can find your username and password in the order confirmation e-mail. If you need your account
information please e-mail info@nextengine.com



- Choose to SAVE the file.

After download is complete, double click the installer file to start Installation.




15 of 162



Accept the License Agreement and click

 It is recommended to install in the

 Every box should be checked and then
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 Click to Install the Software

The latest version of .net is required to

 Make sure the scanner is unplugged
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  Once Installation is complete click



- For an SD scanner and ScanStudio 1.7.3 you will need to be logged in as an administrator to install
and run the software. For HD scanners running HD 1.1.0 and newer you are required to install as an
administrator, but do not need administrator privledges on the computer to run the software.





Connect



- Connect the scanner to the computer's USB port






- For XP and Vista a window will appear alerting you that new hardware has been detected.
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 Select option to Install the software

 When the wizard has completed the



- For Windows 7 the drivers should automatically install once you plug in the scanner.




 The scan arrow



Online
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If you are connected to the internet activation is very simple.




You will be asked to sign-in the first



- If your computer is connected to the internet it should automatically detect your computer and
validate your ScanStudio license.



- Go to Help, About ScanStudio to see which version of ScanStudio you are running 

- Click on Support and go to My Software to see your license status.





Offline



You do not need an Internet connection to use ScanStudio.




 If your computer is offline you will see this



- Please go to this link http://support.nextengine.com/license/setup.
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 Enter in the requested machine information

 Your license will be e-mailed to



- Transfer the license file to your offline computer via a USB drive.

- Save the license file on your computer. 

- Click the license file to launch ScanStudio.





License



ScanStudio Core or HD Licensing:

- Core or HD can be installed on multiple computers.

- If your scanner says HD on the front you will want to run HD, if not run Core.



ScanStudio CAD Tools and HD Pro Licensing:

- CAD Tools and HD PRO are assigned to a single username and can only be used on one computer
per license.
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 To activate, click where it says OFF and then it will say Activating followed by



 License Transfer Procedure 

- Click on Support inside of the application. 

- Go to My Software 

- You need to turn the software OFF on the old computer before activating it on a new machine.





*If you have a question about your license please click ASK and someone from technical support will
help you.
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2.3  Hardware Installation





Scanner



Installing the Scanner:






- Get your USB and power cords out of box






- Plug power cord into outlet and back of scanner






- Plug USB cord into back of scanner and computer USB port
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Note: USB 2.0 is required to handle the large volume of 3D data and images.





AutoDrive



Setting up the AutoDrive and PartGripper:



AutoDrive






PartGripper






- Screw PartGripper into one of four corner sockets on AutoPositioner
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- Tighten Platter on PartGripper






- Rotate Post clockwise (about 6 turns) to tighten PartGripper into AutoDrive






Tripod



Scanner and Tripod






There is a screw hole on the bottom of the scanner for attaching the scanner to a tripod
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Next Step: Download and install ScanStudio -> or if already installed start your first scan
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2.4  Customizing ScanStudio HD





File Management



-Each new scan is named 3D_Scan_## where the ## gets incremented to ensure a unique filename for
each new scan.



-When you capture the first scan in a model, you can specify the filename by entering it in the yellow
status area in top bar of the Scan Setup Panel:






-A new folder will be created in your scan results directory with the specified name.  Your SCN and
JPEG files will be saved into that folder as the scan is captured.



-When you do a File-Save As, ScanStudio will save all of the needed files (SCN, JPEGS, etc.) into the
directory you select, so you should be able to delete the 3D_Scan_## directory once you've done a
File-Save As. 



-File-Save should save your current SCN file wherever it resides, so it should save into the
3D_Scan_## directory unless you have performed a SaveAs or named the model at scan time, at which
point it would save into your specified directory.





Preferences



-The Application Preferences Dialog is available from the Edit-Preferences menu and can be used to
customize ScanStudio to fit your usage
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Scan 

-By default, the scan save directory is located under your My Documents\My 3D folder under your
username. 

-You can customize the directory after installation



Polish

-Turn On/Off Model Backups which can be used to undo changes and restore from corrupted files

-Optionally display a settings dialog as part of AutoTrim

-Turn On/Off the unloading of models while Polish to help save memory

 

2D Texture Display

-Enable/disable texture loading and display (can be disabled to save memory). 

-If it is disabled your model will only be displayed in solid mode.





Performance


Click on Performance to select additional
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Prompt to Upgrade Memory

-Optionally check your system for the minimum RAM needed to run ScanStudio (a warning is
displayed at application startup if your system does not meet the 2GB min. requirements)



Prompt to Upgrade Graphics Card

-Optionally check your graphics card and warn if it is not compatible with ScanStudio (a warning is
displayed at application startup if your graphics card is not supported).

Enable/disable graphics card caching for higher rendering performance.



Monitor Hardrive Space

-Optionally monitor your free hardrive space and warn if your system is running low.



Monitor Memory Usage

-Optionally monitor the amount of available memory (RAM) and warn if your system is running
low.



Graphics Card Caching

-Enable/Disable graphics card caching. 

-If you have an ATI graphics card and experience USB issue you will want to turn this off.

-If you are working with large models and are having a slow response moving the model on the screen
you will want to enable this.



Disable Decimated Point Cloud

- By deafult the decimated point cloud display is enabled.

- It will intelligently reduced the point cloud for accelerated responsiveness.

- You can disable this display option here.
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Chapter 3



 Getting Started

30 of 162



3.1  Setup





Surface Prep



Prepare dark, shiny or transparent objects using included tools to help the lasers capture the data.




Paint Pens: Washes off most

Powder: Talc



Testing has also shown that a spray powder like Magnaflux Spotcheck SKD-S2 Developer works
well for prepping objects prior to scanning. 

Here is  a link to the site where you can purchase. Magnaflux Buy Page




Magnaflux Spotcheck



Other spray alternatives such as foot powder spray or white hairspray can be used as well:
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Foot powder spray from

White Hairspray



White Hairspray Buy Page





Alignment Prep



It may be helpful prior to scanning to make alignment marks using the alignment pen. These marks
will make it easier to place pins and identify locations on the object.  Alternatively, the 3D geometry
that the Scanner captures can be used to align scans.
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3.2  Controls





Mouse Controls




- Right click to zoom.

- Left click to rotate the model.

- Hold down the left and right buttons together to pan.

- Use the center scroll button to pan without selecting an area during trim.





Starting and Stopping



- Click the Start button to run the scan






- Click the Stop button to stop the scan






NextWiki Support Center



The SUPPORT button will take you to the NextWiki Support Center.




Click on
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Browsing



- Click on the Close button to close a scan before starting a new project






- Click on the Browse button to open a previously saved scan
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3.3  Scan 





Intro



- Enter the Scan Panel by clicking the Scan button






- Customize your scan name in the yellow toolbar






There are 3 main types of scans:






360: 

- Select the "360" scan option in the scan panel to scan the object from every angle.

- The number of divisions will control the degree of rotation between scans and the total number of
scans

- The individual scans will be grouped as a family. 



Bracket: 

- Select "bracket" scan in the scan panel to scan three consecutive angles.

- The current viewpoint will be the center scan, with an offset scan to both the left and right of the
current view

- The number of divisions will control the degree of rotation between the left and right offset scans
from the center scan.

- The three scans will be grouped as a family. More on Scans and Families 



Single:

-Single scan of the object from one angle.





Speed



Precision:

Choose MACRO or WIDE distance based on object size and desired resolution
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Macro = 0.005" accuracy, 3x5" field of view 

- Place object 6.5 inches from the front of the scanner



Wide =  0.015" accuracy, 10x13" field of view 

- Place object 17 inches from the front of the scanner



Extended = 0.015"+ accuracy, 16x22" field of view 

- Available with HD PRO

- Objects can be placed up to 30" from the face of the scanner



Speed:



ScanStudio CORE

Choose Standard, Quick or Fine scan speed based on desired scan time and quality






ScanStudio HD/HD PRO




Macro Reference Table
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Wide/Extended Reference Table



Tips

- For ScanStudioHD, go to  Scan -> Settings -> Texture Capture Mode - and choose Monochrome or
No Texture Capture for faster scan speed.






- Choose Fine  or HD Speed for the greatest resolution.

- Choose Quick Speed to capture data the quickest with lowest resolution (not recommended for most
parts).

- Calibration will occur for every scan family (AutoDrive and MultiDrive) by default, but can be
disabled by checking the box for "Disable Scan-time AutoAlignment"





Position



- Orient object in viewfinder using Rotate buttons



Turn/Step Arrows:






- One click on a Turn Arrow rotates the AutoDrive a single increment for more precice positioning.

- One click on a Step Arrow rotates the AutoDrive one division. 

- For example, if the divisions is set at 4, clicking on the step button will rotate the object 90 degrees.


- The left arrow rotates the object clockwise.

- The right arrow rotates the object counterclockwise 



Note: The AutoPositioner should only be rotated using the Rotate Arrows and should not be done
manually.
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Region of Interest

- Drag the cursor around the object to select a smaller scan area






Regenerate



- Since the raw scan data is saved at scan-time, you can regenerate the points at any time with different
point-generation settings. 

- These settings have the same effect as the sliders on the scan setup screen.

- Re-Gen is particularly useful for changing the decimation value after a scan has been completed.



Steps:

- Click on Fuse, Re-Generate Scan(s)






- Select new scan settings for reprocessing
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- Restore Trimmed Data: Choose this option to restore the trimmed data from either a single scan,
family or the entire model.



Next Step: Remove unwanted areas such as the PartGripper using Trim or Align your scans to make a
complete model -> . For tips on viewing your scan ->



- If you have any further questions, please click on the Ask? button.
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3.4  Align





Intro



Note: 

- Prior to scanning, it may be helpful to make alignment marks using the alignment pen. 

- These marks will make it easier to place pins and identify locations on the object. 

- For the Palm Tree image below, the markings on the model can be used for our reference points.





Selecting Scans to Align

- Double click on thumbnail of a family to separate the family into individual scans






Alignment Screen




Click on Align to enter



- When you enter Alignment, you'll see a split screen view

- The left side shows an assembly of scans/families that are already aligned

- The right side shows the next piece that you're attaching to that assembly






Thumbnail Bar
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- The green side contains scans and families that are already assembled

- The blue side is for pieces that aren't part of the assembly yet  

- To break apart or assemble your model, simply drag parts from one side to the other





Single Family



AutoAlign

- By deafult AutoAlignment is enabled and will run for all 360 and bracket scans. 

- To disable AutoAlignment go to Scan ->Settings.






- If AutoAlignment does not result in an accurate alignment, the standard Align tool can be used to
place correspondence points and align the scans.



Alignment for 360 or Bracket Scans

- Place 1 pin on a common location between 2 scans within the family.

- Drag the pin to the location or double click on the point to place the pin.






Attach Scans
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- The yellow status bar will walk you through the process 

- Click "Attach Scans" to add your scan to the assembly






- Click File > Save after each alignment in order to save pin locations

- You can detach a scan by dragging it from the green to the blue and then you can adjust the pin.





MultiFamily



- Multiple families can be aligned together.



- Place 3 pins on common locations between the 2 families




Two pins placed in front

Third pin placed in back
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Attach Scans

- The yellow status bar will walk you through the process 

- Click "Attach Scans" to add your scan to the assembly






- Click File > Save after each alignment in order to save pin locations

- You can detach a scan by dragging it from the green to the blue and then you can adjust the pin.



Next Step: Once it's all put together, learn how to trim and fuse your scan data ->





Align Settings



Advanced Settings






Max Iterations

-Input a value which limits the number of iterations run by the refine alignment algorithm.



Sample Ratio

-1/1, 1/4, 1/9, 1/16, 1/25, 1/36, 1/49 and 1/64. 

-If you are dealing with a large data set, you may sample it. Doing this, the registration result won't be
sacrificed, but the processing time greatly decreases.



Ignore Outlier Verticies

-If checked, data which is far from the average will be ignored during calculation. 



Allow only small transform

-The entire overlapped region is considered while assuming that the initial alignment is already well
done. 

-It is recommended to check this option if there are few geometric features in the overlapped region.



Disable small transforms wizard for turntable alignment

- By default the small transforms wizard is on.

- The wizard automatically detects when the small transforms method should be used to improve
alignment results.

- It can be disabled here if it is not helping alignment results.
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Disable Refine after pin alignment

- By default the alignment is automatically refined after the initially pin alignment.

- If the refine alignment is not improving the alignment results it can be disabled here.







Fixing Scans



When aligning multiple families it may be beneficial to lock the individual families in place so that
any future alignment does not disrupt the already aligned families.



Fixing a Single Family

-After your single family alignment is complete (double click on the family if you need to expand it
out), then go to Align, Settings.






-Check the box "Fixed (will not be moved by alignment)" for scans A1-An. This will lock the
individual scans in the family and not be moved with future alignment.

-If you check the Fixed button for the Family A tab, then this will lock the entire family in place and
not just the individual scans for that family.






Fixing Multiple Families

-For multiple families, go to Align, Settings and check the box "Fixed (will not be moved by
alignment)" for the families that have been sucessfully aligned and wish to be locked in place.
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Example:

- Starting out with three families (One 360 and two brackets)

- Attach Family A to Family B (both families are not fixed)

- Go to Align, Settings and check "Fixed" for Family A and Family B (They are now locked in
position)

- Proceed to attach Family C to A and B.

- After C is sucessfully aligned, then go to Align, Settings and fix Family C

- Repeat for any additional family attached.
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3.5  Trim





Intro



- Back up your scan file as a different copy unless ScanStudio has not done so already.




Click the 'Trim' button in the



- Click the cirlce/square/square selector/poly selector button in the toolbar to select data






- Select the area on the scan to be removed and continue selecting until all unwanted area is
highlighted

- To remove selected area, click on the "Trim"  button in the toolbar 

- Continue the process until all unwanted area has been removed




Before Trim After Trim



Deselecting



- If an area is incorrectly selected it can be deselected before trimming takes place.

- To deselect an area, click on the "minus sign" in the toolbar, which will turn the selectors to blue






- Then click on the area to be deselected.

- Click on the "plus sign" in the toolbar to return the circle/square to red and resume selecting area to
be removed
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- Select "undo" under Edit in the toolbar to undo the last trim. (This will only work if you have
Enabled Model Backups)

- You can also restore trimmed data through Regeneration of your scan found here: ->





Navigating



- Click on the "pointer button" before zooming or repositioning the object






- Drag object up/down while right clicking to zoom. 

- Drag the object while holding down both mouse buttons to pan  ->.

- Hold down center scroll to rotate object without selecting any areas.





When to Trim



- You can trim completed individual scans of 360/bracket scans while other scans are finishing. 

- Before alignment you should not trim away parts of the object, only parts of the PartGripper.

- After alignment you can trim overlapping data to improve fusing/merging. 

- Double click on the aligned family and drag the scan to be trimmed into the blue thumbnail bar






Next Step: Fuse your scans to remove any remaining overlap -> or align your scans if needed ->





AutoTrim



- Auto-trimming automatically detects and removes data that was captured at a steep angle relative to
the line of sight of the scanner. 

- This can be useful in removing data that may negatively affect alignment or blending.



- Auto-trimming is available under the Polish menu and should be run before aligning, fusing or
merging multiple scans together.






- With this option selected you can choose the angle for trimming.
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If you have any further questions, please click on the Ask? button.
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3.6  Fuse





Fuse



The Fuse tool Volume Merges, Remeshes, Fills Holes and Simplifies your aligned scan data.



- Ensure that the data that you would like to fuse is aligned in the green section of the bottom view
bar.




Click Fuse

Choose Simplification Level



- Enter the desired deviation tolerance for any mesh simplification (decimation)

- 0.00" simplification will not simplify the data

- Increasing the simplification will simplify your model and make the file size smaller.

- It will perform intelligent simplification, which keeps more points in detailed areas and fewer points
in larger planes.




Click to enter Settings



- The Hole Filling Slider controls the max. circumference size of holes to fil.

- Control how much blending of the textures to perform (to account for brightness variations): 

- Resolution Ratio determines the new average vertice length in relationship to the current length. 


49 of 162



- Values less than 1 will decrease your triangle size. Values greater than 1 will increase your triangle
size.

- It is best to keep this at the default of 0.9. 




Click FUSE

New family C is created



Volume Merge



The Volume Merge tool eliminates the overlap from multiple scans and merges them into a single
mesh.



Volume Merge can be used in place of Fuse if you do not wish to Remesh or Hole Fill your scans.



To Merge multiple scans into a single mesh:



- Ensure that the scans to merge are in the green section of the bottom view bar.




Select Volume Merge
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Resolution Ratio

 - Controls the size and amount of triangles that will be in the merged result. 

 - It is best to keep it at the default of 0.9.

 - Values from 0-1 will result in smaller triangles than those presently in the scan.  

 - Values larger than 1 will result in larger triangles with a possible loss of detail.

 

Adaptive Meshing

- Adaptive Meshing will intelligently reduced the point cloud of the final merged model.




New family C is created



The Merge process will not automatically fill holes in the mesh where there is no scan data.

You can use the Remesh option after a Merge to create a water-tight mesh (more info: ->).





Fusing Large Models



- The number of points that can be merged or fused at one time is dependant on the Computer Specs. 

- To fuse/merge larger models we recommend these specs:



CPU: 

Dual Core, Quad Core or i7 processor
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Memory: 

4+ GB RAM



Graphics Card: 

512+ MB GPU (Dedicated, non-integrated)



Operating System: 

Windows XP 64 Bit

Windows Vista 64 Bit

Windows 7 64 Bit



You can check the number of points in your model under File->Model Information.






To reduce the number of points in your model Regenerate your data a higher simplification level.

See next section for instructions for regenerating.





Regenerate



Since the raw scan data is saved at scan-time, you can regenerate the points at any time with different
point-generation settings. These settings have the same effect as the sliders on the scan setup screen.



Re-Gen is particularly useful for changing the simplification value after a scan has been completed.



Steps:
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Click Fuse, Re-Generate

Select new settings for reprocessing



- Higher Simplification values will result in fewer points in the model. 

- Simplification level of 2 will result in 1/4 of the original data, level 3 will result in 1/9 of original
data...

- Simplification can be increased and decreased at any time without losing original data.

- Restore Trimmed Data: Choose this option to restore the trimmed data from either a single scan,
family or the entire model.





Texture Quality



Texture Blending 



- Prior to fusing there is overlap between scans. 

- When you fuse a model the best 3D data for each point is kept and the rest is removed to create a
single mesh. 

- There may be varying shadows on the final fused result depending on which 3D data and associated
texture remains post fuse. 



 Tips to improve textures: 



- Ambient lighting- Minimizing the ambient lighting in the room can help improve textures.



- Object Distance- If you are repositioning the object make sure to keep the same approximate distance
to reduce color variation.



- Shadows- Try to minimize shadows as much as possible. Keep in mind the PartGripper can cause
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shadows. Prior to scanning you can preview the rotation using the STEP and TURN buttons in the
scan panel. If necessary you can adjust the position of the rotations to reduce shadows. If you have a
single scan with an extreme shadow you can try to trim out the shadow as long as the data was capture
from a different angle.
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3.7  Polish





Hole Fill



- Enter the Polish panel.






- Select the Fill tool.




Holes are automatically detected



Note: Please make sure that when using the Fill tool, you are working with a fused, merged or a single
scan model.



- Use the selector tools to select the holes that you would like to fill.
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Selected holes will turn orange



- When you finish your selection(s), select the Fill button to permanantly commit these triangles into
your model.




After Fill
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Auto Hole Fill



To have ScanStudio automatically fill holes in the scan data:



- Ensure that the data that you would like to fill holes on is a volume merged model in the green
section of the bottom view bar.






- Select the Fill Holes tool from the Advanced Polish Menu.






- Enter desired Hole Filling Settings.






a. FILL METHOD: 

          - Flat Fill will fill the holes along a flat edge.  

          - Smooth Fill will fill the holes along a smooth edge.

          - Curvature Fill will analyze the neighboring geometry and try to match the overall curvature.

b. MAX VERTICES: Controls the maximum number of vertices for holes to fill.  Increase to fill more
holes.

c. LEAVE LARGEST: Enable this option to leave the largest hole in the scans.

d. SMOOTH BOUNDARIES: Enable this option to smooth the vertices on the edge of the holes as
part of the fill process.



You can also use the Remesh tool to automatically fill holes in merged data: ->

You can alternatively use the ScanStudio manual hole filling tool to manually select and fill holes
(more info: ->).



If you have any further questions, please click on the Ask? button.
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Buff



- Click on the Polish tool.






- Then click on the Buff tool.






Note: When buffing, please make sure that the model is a fused or merged model.



- Select localized data to smooth or all for the entire mesh.




Selected data will be highlighted red



Settings



3. Enter the desired buff options:




58 of 162





a. Buff Method: Laplacian and Loop are two different smoothing methods.  The Curvature option can
be used for curvature based smoothing.

b. Buff Weight: Increase to run a higher level of smoothing (when the Loop method is used, the
number of iterations is all that needs to be specified, the smoothing weight has no impact).

c. Deviation Tolerance: Optionally enter the allowable deviation for the smoothing.

d. Max Iterations:  Increase to run more iterations of smoothing and therefore reduce more noise.

e. Smooth Boundaries: Enable this option to smooth vertices around the edges of holes.

f. Preserve Sharp Edges Enable this option to try and retain sharp edge detail.



Results




Before
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After



If you have any further questions, please click on the Ask? button.





Simplify



Note: When using the Simplify tool, please make sure that you are working on a fused or merged
model. Simplifying prior to fusing/merging will create non-uniform mesh.  Please regenerate scans if
you need to decrease model size before fusing (more info -> ). 





- Click on the Polish tool.






- Click on the Simplify tool.






- Select the local data to simplify or select all.
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- Choose the desired simplification tolerance from the top menu bar slider.






- Click the SIMPLIFY button.




Before Simplify
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After Simplify



If you have further questions on the simplify tool, please click on the Ask? button.





Remesh



- Ensure that meregd or fused model is in the green section of the bottom view bar






Note: It is advised to remesh scans that have been merged/fused. For more info: ->.



- Select the Remesh tool from the Advanced Polish Menu.




Choose Remesh Settings



Resolution: Controls the size and amount of triangles that will be in the remeshed result. 
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              Values from 0-1 will result in smaller triangles than those presently in the scan.  

              Values larger than 1 will result in larger triangles with a possible loss of detail.



Fill Holes: Select the Hole Filling Settings to fill some or all holes.






Fill Method: You can experiment with the different fill methods to see which works best for your
model and the sizes and shapes of the holes.



Smooth Boundaries: Select this option to smooth the boundary of the newly filled holes.



Keep Largest Hole: If your object has an opening that is part of the design select this option to keep
that hole from filling.



Keep Holes Larger Than: If you don't want to fill all holes, then you can manaully set which holes
of circumference size to fill.



The Remesh tool can be very useful when run after Merging Scans to create a water-tight mesh.  





If you have any further questions, please click on the Ask? button.





Clean Defects



Clean Defects should be run at the end of your polishing process and can be used to automatically
eliminate any self intersecting or non-manifold triangles.



To Clean Defects in your mesh:



1. Ensure that your Merged and Remeshed model or fused model is in the green section of the bottom
view bar.
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2. Select "Clean Defects" from the Polish - Advanced menu.






Any defects in the mesh will be automatically detected and cleaned.



If you have any further questions, please click on the Ask? button.
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3.8  Orient





The Orient Tool can be used to define an origin and Orient your scan data in a defined global
coordinate space.



- Click on the CAD button from the top toolbar to enter the CAD toolbar:






- Select Orient to enter the Orient toolbar:






- ScanStudio will show a bounding box representation of the common view planes (top, left, front,
etc.):






Settings






Rotate

- First option to rotate both bounding box with model

- Second option is to rotate the model with a fixed bounding box

- Third option is to rotate the bounding box with a fixed model



Constrain

- Use the constrain buttons to limit rotations on the x, y or z axis



Base

- Click the base button and place 3 pins on the object to define one of the common view planes of the
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bounding box:






Faces

- Click on faces to view the front, back, left, right, top and bottom locations






Origin

- Click on the origin button and place 1 pin on the mesh to define the origin.



Notes: Mesh scan data can be globally oriented, but CAD data cannot.
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3.9  Measure





Volume Measurement



- Ensure that your fused or merged and remeshed data is in the green section of the bottom view bar.

- Select Volume from the Measure menu:






- The calculated volume will be displayed:






- This tool is only available with the ScanStudio CadTools upgrade. 





Surface Area Measurement



- Ensure that your fused or merged and remeshed data is in the green section of the bottom view bar.

- Select Surface Area from the Measure menu:






- The calculated surface area will be displayed:






Point to Point Measurement 



- To measure a distance on a scan you can click on one point then press the letter "i" on your keyboard.


- This will give you the coordinates of that point. 

- Then do the same at your second point and it will give you the new coordinates along with the
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distance to the previous point.
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3.10  Output





- Click the OUTPUT button to ouput the scan model.






-Choose the type of file you want to output






You can also export through the File-> Save As option.






Mesh Files






- ScanStudio HD allows the export of PLY, U3D, OBJ, XYZ, STL and VRML files.



NZIP Files



- An NZIP file is a compressed ScanStudio file that contains the SCN file and associated JPEGS 

- It is useful if you need to transfer a scan file to a different computer. 

 


69 of 162



3D Print



Currently in development.



IGES and STEP Files



- Exporting IGES and STEP files is only available with ScanStudio CadTools. 



- For more information about upgrading to CadTools please contact info@nextengine.com.



- Mesh data cannot be exported as an IGES/STEP file.



- Insure the model contains either splines or autosurfaces in the green section of the toolbar (for more
info click here ->).




Select

Name your scan, choose the ouput units, click



Rapidworks



- Directly transfer a fused or unfused model from ScanStudio to Rapidworks. 

- Surfaces and Splines cannot be transferred.




Select Rapidworks
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- Output your currently loaded model as is.






- If you are exporting unfused scans, you have the option of Regenerating the scan data during the
export process.



- Choose to ouput the Selected Scan Family, Attached Data (in the green) or the Entire Model.





Solidworks



- Fused or merged scans can be directly transferred to Solidworks Office Premium.

- To enable the transfer the ScanTo3D add-in must be loaded in Solidworks. 

- To load the add-in go to Tools-> Add-ins in Solidworks.



U3D



- Due to our shift to a 64 bit platform we no longer support the U3D file format. 

- ScanStudio 1.1.1 is still available for download and it does have the option to export U3D files.

- Download it at this link: ->

- If Adobe updates the U3D file format we will reimplement it in future ScanStudio versions. 



For more information on using your scan data in Solidworks click here ->.
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Chapter 4



 ScanStudio HD Add-Ons
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4.1  MultiDrive





Setup



-Here are the items that are included with the MultiDrive:




Allen wrench and L Bracket AutoPostioner



-Attach the L Bracket to the MultiDrive with two flat head screws and allen wrench






-Attach the MultiDrive to the bottom of the scanner and fasten a screw underneath the scanner for
additional stability
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-Plug in the MultiDrive to the scanner






-Start ScanStudioHD and proceed to Calibration





Calibration


When starting your first scan in



-"Start" to begin the automated calibration process (We suggesting using the palm tree included with
the MultiDrive)

-"Skip" if you wish to proceed to the scan panel and choose 

-"Learn More" to be directed to this help page.




You can



-This function is available for re-calibration when alignment results in an error or when the MultiDrive
was detached and is reattached.





Scan Process


After calibration is
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A new scan panel will be loaded when



-Five families are now available for predefined settings for Positioning, Divisions, Start Angle, Tilt
Angle, Points/IN^2 and Target 

-Clicking on the family name will enable the tab to edit the settings.

-To enable or disable a family, simply check or uncheck the circle next to the family name.

-Starting positions can be set for both the initial and tilt axis by moving the slider bar arrow.

-The start axis has the full 360 rotation and tilt axis is bounded to -35 to 45 degrees.

-Use the top slider bars to visually set the starting and tilt positions. (This will update the settings for
the scan family)






-Select the scan settings for each tab and check the tabs you want to have scan. 

If the setting for a tab have been adjusted, but the tab is not checked it will not scan.
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-All MultiDrive scans are to be in MACRO mode.

-Select a ROI for your model to prevent the MultiDrive from being scanned in for certain tilt angles.

-If additional scans are needed, enter scan panel and position the model by using different starting and
tilt angles to capture additional scans. 

-If you physically adjust the part, then a 3 pin alignment will be needed to align.

-When finished, trim unnecessary data and "Fuse" or "Volume Merge" the model for export: ->





Troubleshooting



Warning

- Do not use the AutoDrive PartGripper with the MultiDrive as the length of the pole will cause it to
hit the scanner when the MultiDrive is positioned at certain angles.



Switching between AutoDrive and MultiDrive 

- Simply plug in an AutoDrive to display the proper UI. 

- When reattaching the MultiDrive, make sure to recalibrate as needed.



- When more than 5 Scan families are required, then just click on scan to enter the scan panel, and you
can add 5 more new sessions. These scans should auto align to the previous scans assuming all the
movement and rotations were done by the turntable. If they don't auto-align , just drag the scans into
the green and refine (no pins required)



- Force Calibration. If your scans are not coming in aligned, you may need to run a force calibration.
You can do this from the drop down menu , Align, then go down to Calibrate MultiDrive





Dental



Recommended Scan Settings for Dental Cast Models
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Family A Divisions: 6  Tilt: -10

Family B Divisions: 6  Tilt: 45 degrees



-Use the HD speed for higher resolution
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4.2  QA-Scan
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4.3  HD PRO






SCANSTUDIO HD PRO



4x Data Capture

HD scan speed allows for a maximum point cloud resolution of .0025", thereby capable of capturing
finer details and smaller objects.



Extended Wide Mode Scanning

In the scan panel select Extended mode ito increase the depth range to 30 inches from the scanner. 
The maximum field of view in Extended mode is 16 x 20". There will be a degradation in the accuracy
of the scan results at these distances, it is suggested that you scan white objects for best results.



Faster Laser Scan Time 

With HD PRO activated the laser scan time is nearly twice as fast. 



Activating HD PRO 

To activate HD PRO click on Help>My Software and activate on the My Software page.





To purchase the HD PRO license visit the buy page here. 

This software requires an HD capable scanner. For more information click the ASK button
below.
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4.4  CAD Tools





Intro




SCANSTUDIO CAD TOOLS



Auto Surfacing

1 - Button creation of NURBS surfaces.  CAD TOOLS creates a patch network of surfaces on your
mesh models for easy IGES and STEP export. 



Spline Creation

Defined spacial splines can be created with ease.  Simple curves are traced from your mesh models
and are great for referencing size and shape.



File Export

Easy output of Splines and Surfaces as IGES or STEP.



Activating CAD TOOLS 

To activate CAD TOOLS click on Help>My Software and activate on the My Software page.



To purchase the CAD TOOLS license visit the buy page here. 

For more information click the ASK button below.





Spline



The Spline Tool can be used to extract boundary curves from your mesh data.



- Ensure that the Fused mesh data that you wish to convert to splines is in the green section of the
bottom view bar.
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Select CAD

Select SPLINE



- ScanStudio will automatically calculate and display a bounding box which can be used to define the
plane cuts to use to extract the boundary splines:




AXIS button to change which face from

SPACING slider to control how far apart

 The BOUNDS tool to control which

ORIENT tool to position the mesh data
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Use the Rotate tools to move either the mesh data, the bounding box, or both.

     The Constrain tools can be used to limit rotation along a particular axis.

     The Base tool can be used to define one of the planes in the bounding box by placing pins on the
mesh




Click SPLINE to complete



The set of splines created will be added to a common "Spline" family off of the root of the model.






AutoSurface



The AutoSurface Tool will automatically create a patch network of surfaes from the mesh model.
This can be easily exported as an IGES or STEP file.
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- Ensure that you have merged results in the green section of the bottom view bar:




Select CAD

Select

Choose the Number of



More surfaces may result in more accuracy.

     If the resulting surfaces have missing data then try increasing the number of surfaces.




Click SURFACE



-The resulting surfaces are stored in the SCN file and displayed






Output
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- Exporting IGES and STEP files is only available with ScanStudio CAD TOOLS. 



- For more information about upgrading to CadTools please contact info@nextengine.com.



- Mesh data cannot be exported as an IGES/STEP file.



- Insure the model contains either splines or autosurfaces in the green section of the toolbar




Select Output

Select

Alternate Export

Name your scan, choose the ouput units, click
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4.5  ProCare






ScanStudio HD ProCare

- Extended 3 years of Online Support through the NextWiki Support Center with access to Technical
Support and Online Documentation.

- Standard Technical Support terms end after 1 year, Online Documentation will remain available for
reference.

- Live online chat with expert Applications Engineers who can help with troubleshooting, scanning
tips and custom workflow documents for your individual application.



ScanStudio HD ProCare Pricing

$295 - ScanStudio HD ProCare must be purchased within 90 days of original Scanner purchase.



To purchase the ScanStudio HD ProCare visit the buy page here. 

For more information click the ASK button below.
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Chapter 5



 Rapidworks
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5.1  Getting Started
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5.2  Mesh Cleanup and Autosurfacing
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5.3  Solid Modeling
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5.4  Surface Modeling




90 of 162



5.5  Hybrid Modeling
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5.6  ProCare






Rapidworks ProCare

- 3 years of Major and Minor Updates to RapidWorks

- Access to the Rapidworks Success site

- Access to the support engineers at Rapidform for more personalized help with models.





Without Rapidworks ProCare

- If ProCare is not purchased users will not be updated on Major or Minor Releases.

- Updates willl only include bug fix releases such as 2.3.x to 2.3.xx.

- Users have 90 days to purchase Rapidworks ProCare at the $995 price, after that it is pro-rated.

- Online help through the NextWiki and the included PDF User Manual only.

- Engineers cannot work on specific models and upload it for users.

- No phone support





RapidWorks ProCare Pricing

- Within 90 days of RapidWorks purchase = $995

- 90 days - 1 year = $1490

- 1 year - 2 years = $1985

- 2 years - 3 years = $2480

- After 3 years = $2975



Rapidworks ProCare can be purchased at  https://www.nextengine.com/store

Upon purcashing ProCare, e-mail support@rapidworks3d.com or call (408) 856-6200 x2 to sign up
for the Rapidworks Success website.
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Chapter 6



 QA Scan
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Chapter 7



 QA-Scan
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Chapter 8



 Other 3D Programs
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8.1  SolidWorks






http://www.solidworks.com/



-Solidworks Premium (and Educational version)

The Scanto3D Add-In allows you to import and reference mesh scan data in your 3D design.





-Other Solidworks Versions (Standard/Professional)

If you do not have the Premium version and the Scanto3D Add-In you can use ScanStudio CAD
TOOLS -> to create surfaces or spines from your scan data, and then export the surfaces or splines as 
IGES or STEP. 

You can also use RapidWorks -> , which allows the user to recreate a Solid Model from the Scan data,
then export a fully featured part into SolidWorks native SLDPRT file format.
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8.2  RapidForm XO






Rapidform XOR2

Rapidform XOV2

Rapidform XOS

InspectWorks

Rapidform Explorer



http://www.rapidform.com





Rapidform XOR2



-Go to Insert - Import and under the dropdown for file type select NextEngine files (*.scn):
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8.3  Geomagic






http://www.geomagic.com/en/



Geomagic Studio

"Transform 3D Scan Data into Accurate Digital Models. Designed to handle the most demanding
reverse engineering, product design and rapid prototyping challenges, Geomagic Studio transforms 3D
scan data and polygon meshes into accurate 3D digital models. A perfect complement to the CAD,
CAE and CAM tools you already own, Studio outputs industry standard formats including STL, IGES,
STEP and native CAD files."
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8.4  ArtCAM






ArtCAM

http://www.artcam.com/





Here is a great new Forum from users combining the NextEngine 3D Scanner and ArtCAM:

http://forum.artcam.com/viewtopic.php?f=5&t=8143
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8.5  Mesh Lab






MeshLab

http://meshlab.sourceforge.net/



"MeshLab is an open source, portable, and extensible system for the processing and editing of
unstructured 3D triangular meshes.

The system is aimed to help the processing of the typical not-so-small unstructured models arising in
3D scanning, providing a set of tools for editing, cleaning, healing, inspecting, rendering and
converting this kind of meshes."





Imports all mesh files; STL, OBJ, PLY, XYZ, VRML ->
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8.6  Magics






MATERIALIZE MAGICS

http://www.materialise.com/materialise/view/en/2408555-Magics.html



- Software for the Rapid Prototyping and Manufacturing Professional.



- Import VRML, STEP and IGES files from ScanStudio HD and ScanStudio CAD Tools into
Magics.
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8.7  Maya






AUTODESK MAYA





http://usa.autodesk.com/adsk/servlet/pc/index?siteID=123112&id=13577897
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8.8  MudBox






Mudbox

http://usa.autodesk.com/adsk/servlet/pc/index?siteID=123112&id=13565928



"AutoDesk Mudbox software is an advanced, high-resolution, brush-based digital 3D sculpting and 3D
painting solution. Mudbox features and functionality address the needs of professional modelers
working in the game, film, television, and design industries."





-You will need to export your model from ScanStudio as an OBJ file. ->



-Select 'Open a File...'






-OBJ File Loaded into Mudbox






-Using the sculpting tools you can quickly redesign your model
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8.9  ZBrush






 ZBrush

"ZBrush is a digital sculpting and painting program that has revolutionized the 3D industry with its
powerful features and intuitive workflows. Built within an elegant interface, ZBrush offers the world's
most advanced tools for today's digital artists. With an arsenal of features that have been developed
with usability in mind, ZBrush creates a user experience that feels incredibly natural while
simultaneously inspiring the artist within. With the ability to sculpt up to a billion polygons, ZBrush
allows you to create limited only by your imagination."



Check out the website for full details, gallery, and to download a 30-day trial.

http://www.pixologic.com/home.php



To Load your scan model in ZBrush you will need to export your model as a STL or OBJ file -
>

After opening Software Select Open Model (STL or OBJ)






Select the STL/OBJ file from the directory and the model will load in the app:
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8.10  Blender






Blender

http://www.blender.org/

"Blender is the free open source 3D content creation suite, available for all major operating systems
under the GNU General Public License."



Download Blender here:

http://www.blender.org/download/get-blender/
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8.11  AutoDesk





You can now import IGS files by installing Parasolid Plug-In on the Autodesk Labs site.



Here is the link : http://labs.autodesk.com/utilities/translator_add-ins_for_autodesk_/



You can access the translator using the standard Open command in Inventor.  You can choose various
file types to open and in this case I chose IGES as the file type.  Once a file is selected you can choose
the Options button on the Open dialog.  For IGES files youll get the dialog below.






If it is water tight it will result in a solid as seen below.






If the objects have holes they will import in as surfaces.  The result ended up in Inventors Construction
environment with the idea that you can use the tools there to clean up the model and import it into
Inventors parameter environment as either a solid or as a surface.  The picture below shows the
Blackberry in the construction environment.
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8.12  Rhino






http://www.rhino3d.com/



You can open your SCN files directly in Rhino 4.0 by downloading the SCN file importer plugin
from: 

http://en.wiki.mcneel.com/default.aspx/McNeel/NextEngine.html



If you do not have the plug-in installed, or if you are using Rhino 3.0, you will need to export
your scans as an OBJ or STL file. ->





Inside ScanStudio: 

1. Make sure the model is fused. ->

2. Drag the blended family thumbnail into the green side of the bottom view bar.

3. If you have the SCN importer for Rhino 4.0, simply save your SCN file and then open it in Rhino. 
If you do not have the SCN importer, then goto File > Save As > and change the file type to OBJ and
save an OBJ file. 





Inside Rhino:

Please download the following tutorials for information on working with imported meshes in
Rhinoceros: 

http://www.nextengine.com/Rhino_Scan_Remodel.pdf

http://download.mcneel.com/download.asp?id=STLRepair
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8.13  Mathematica






Mathematica

http://www.wolfram.com/products/mathematica/index.html





STL model loaded as 3D Graphic in Mathematica
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8.14  3D Studio Max






http://www.resources.autodesk.com/med/Autodesk_3ds_Max



OBJ Scan Model Loaded in 3D Studio Max
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Chapter 9



 Reference
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9.1  User License Agreement





NEXTENGINE, INC. SOFTWARE LICENSE AGREEMENT 3D DESKTOP SCANNER AND
SCANSTUDIO SOFTWARE PRODUCTS



These license terms are an agreement between you and NextEngine, Inc. Please read them. They apply
to the software that accompanies these license terms, which includes the media on which you received
it, if any, your 3D Desktop Scanner device, and accessories. The terms also apply to any NextEngine
updates, supplements, Internet-based services, and support services for this software and the
accompanying licensed device, unless other terms accompany those items. If so, those terms apply.



BY CLICKING ON THE AGREE BUTTON BELOW, YOU ACKNOWLEDGE THAT YOU HAVE
READ THIS AGREEMENT, UNDERSTAND IT, AND AGREE TO THESE TERMS. IF YOU DO
NOT ACCEPT THE TERMS, NEXTENGINE DOES NOT LICENSE THE SOFTWARE TO YOU,
AND YOU SHOULD CLICK ON THE "DON'T AGREE" BUTTON BELOW TO DISCONTINUE
THE INSTALLATION PROCESS.



AS DESCRIBED BELOW, USING THE SOFTWARE ALSO OPERATES AS YOUR CONSENT
TO THE TRANSMISSION OF CERTAIN COMPUTER INFORMATION DURING ACTIVATION,
VALIDATION, AND FOR INTERNET-BASED SERVICES. 

IF YOU COMPLY WITH THESE LICENSE TERMS, YOU HAVE THE RIGHTS BELOW FOR
EACH LICENSE YOU ACQUIRE. 





1. OVERVIEW.



This software package contains multiple products (e.g. ScanStudio CORE, ScanStudio HD,
ScanStudio HD PRO, ScanStudio CAD Tools, etc.), each of which is separately purchased and
activated.  These products are licensed for nodelocked use from a single installation, as defined by this
license agreement.  For the avoidance of doubt, the products in this software package must be installed
onto the same computer, and the individual products cannot be split up and installed onto separate
computers.





 2. INSTALLATION, LICENSING REQUIREMENTS, AND USE RIGHTS.



a. Software Installation.

The software license is permanently assigned to the 3D Desktop Scanner device with which you
acquired the software. That device is the licensed device.  You may install and use the software only
from a single computer that is owned and controlled by you.



b. Acceptable Use.

You agree to install, maintain, and use the software according to the documentation supplied by
NextEngine; to follow NextEngine's instructions for installing updates and upgrades and for correcting
and circumventing bugs; and to abide by all of the terms of this license agreement.



c. Term and Termination.

This license agreement is effective until terminated. You may terminate it at any time by destroying all
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copies and portions of the software and documentation. It will also terminate immediately if you fail to
comply with any term or condition of this license agreement. Upon such termination, you agree to
destroy all copies and portions of the software and documentation.



d. Separation of Components.

The components of the software are licensed as a single unit. You may not separate the components
and install them on different devices. 



e. Remote Access.

The single primary user of the licensed device may access and use the software remotely from the
computer. You may allow other users to access the software to provide you with support services. You
do not need additional licenses for this access. No other person may use the software under the same
license at the same time for any other purpose.



f. Sample and Tutorial Files.

You may copy and use the sample and tutorial files provided with the software for your own personal
training purposes only, unless permission is otherwise granted in writing by NextEngine. 



g. Trial and Conversion.

Some or all of the software may be licensed on a trial basis. Your rights to use trial software are
limited to the trial period. The trial software and length of the trial period are set forth during the
activation process. You may have the option to convert your trial rights to perpetual rights. Conversion
options may be presented to you at the expiration of your trial period. After the expiration of any trial
period without conversion, most features of the trial software will stop running.



h. Development Tools.

The software may contain a software development kit (SDK), including code libraries and
development tools. You may only use this SDK to design, develop, test, use, and demonstrate your
programs with the software.



i. Pricing and Payment.

Fees for the license granted hereunder shall be due before licensing unless otherwise negotiated with
NextEngine.  The effectiveness of the licenses granted hereunder is conditioned on the receipt by
NextEngine of all applicable fees. 





3. SOFTWARE ACTIVATION.



Activation associates the use of the software with you, a specific licensed device, and with a specific
computer. During activation, the software may send information about the software, licensed device,
user, and computer to NextEngine. This information includes the version, language and the product ID
of the software, Internet protocol address of the computer, and information derived from the hardware
configuration of the device. By using the software, you consent to the transmission of this information.
Some changes to your computer components or the software may require you to reactivate the
software.



The software may verify from time to time that it has been activated and properly licensed. During a
validation check, the software may send information about the software, licensed device, user, and
computer to NextEngine. BY USING THE SOFTWARE, YOU CONSENT TO THE
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TRANSMISSION OF THIS INFORMATION. If the software is not properly licensed, the
functionality of the software may be affected. For example, you may need to reactivate the software,
or receive reminders to obtain a properly licensed copy of the software, or not obtain certain updates,
upgrades or services from NextEngine.





4. COMPLIANCE WITH LICENSES.



If you are a business or organization, you agree that: 



a. Upon request from NextEngine or NextEngine's authorized representative, you will  document and
certify within thirty (30) days that your use of NextEngine software at the time of the request is in
conformity with your licenses granted by NextEngine. 



b. NextEngine may, at its expense, direct a recognized independent accounting firm to audit, during
normal business hours, the number of persons using the software. Representatives of the auditing firm
shall protect the confidentiality of your information and abide by your reasonable security regulations
while on your premises. If your use exceeds the terms of this license agreement, then you will be
invoiced for any additional license fees necessary to bring you into compliance. This invoice shall be
payable within fifteen (15) days of delivery. If the amount of such invoice is greater than five percent
(5%) of the aggregate amount of all license fees paid or payable by you to the date of the audit, you
will pay all expenses associated with such audit. 





5. INTERNET-BASED SERVICES.



NextEngine may provide Internet-based services with the software, and NextEngine may change or
cancel these services at any time. These software features connect to NextEngine or service provider
computer systems over the Internet and may transmit information pertaining to your computer,
licensed device, software, usage, user, software errors, and bugs. BY USING THE SOFTWARE,
YOU CONSENT TO THE USE OF THESE SERVICES AND TRANSMISSION OF THIS
INFORMATION.



You may not use these services in any way that could harm them or impair anyone elses use of them.
You may not use the services to try to gain unauthorized access to any service, data, account or
network by any means. 





6. SCOPE OF LICENSE.



The software is licensed, not sold. This agreement only gives you some rights to use the software.
NextEngine reserves all other rights.



Title, ownership rights, and intellectual property rights (including without limitation all applicable
rights to patents, copyrights, trademarks and trade secrets inherent therein and appurtenant thereto) in
and to the software (including without limitation any images, data, animations, video, audio, music,
and text incorporated into the software), and all copies of the software, are owned by NextEngine
and/or its licensor(s), as applicable, and are protected by U.S. copyright laws and international
copyright treaties, as well as other intellectual property laws, treaties, and federal and state trade secret
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laws. Nothing in this license agreement constitutes a waiver of NextEngine's rights under U.S. or
international copyright law or any other federal or state law.



Unless applicable law gives you more rights despite this limitation, you may use the software only as
expressly permitted in this agreement. In doing so, you must comply with any technical limitations in
the software that only allow you to use it in certain ways. For more information, see the software
documentation. 

You may not:

work around any technical limitations in the software; reverse engineer, decompile, disassemble, or
reduce the software to human-perceivable form, except and only to the extent that applicable law
expressly permits, despite this limitation; modify, adapt, translate, or create derivative works except as
authorized by the documentation; remove any proprietary notices or labels on the software, make more
copies of the software than specified in this agreement or allowed by applicable law, despite this
limitation; publish the software for others to copy; use the software in any way that is against the law;
rent, lease, lend, sublicense, or otherwise transfer any or all of the software or rights granted by this
license agreement except as expressly provided herein; or use the software for commercial online
services, service bureau, or time-share services to third parties without NextEngine's prior written
consent, which may be withheld or denied in NextEngine's sole and absolute discretion, and is subject
to payment of such additional license fees as NextEngine may require.





7. DERIVATIVE WORKS.



You agree that NextEngine owns all rights, title, and interest in and to any changes or suggested
changes made by you to the software, and you agree to execute any and all assignments or other
documents necessary to convey such ownership rights to NextEngine.





8. BACKUP COPY.



You may make one backup copy of the software media and use it only to reinstall the software. 





9. DOCUMENTATION.



Any person that has valid access to your computer or internal network may copy and use the
documentation for your internal, reference purposes. 





10. TRANSFER TO A THIRD PARTY.



You may transfer the software directly to a third party only with the licensed device and this
agreement. Before the transfer, that party must agree that this agreement applies to the transfer and use
of the software. You may not retain any copies.



All software licenses are bound to the licensed device.  Sale of the licensed device automatically
conveys all software licenses associated with the device to the new device owner.  You may not sell
the software products separately from the licensed device.
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11. UPGRADE OR CONVERSION.



To upgrade or convert software, you must first be licensed for the software that is eligible for the
upgrade or conversion. Upon upgrade or conversion, this agreement takes the place of the agreement
for the software you upgraded or converted from. After you upgrade or convert, you may no longer
use the earlier version of the software you upgraded or converted from.



Minor software updates and bug fixes may be available at no cost, while major software upgrades may
require purchase. You may only obtain updates or upgrades for the software from NextEngine or
authorized sources.





12. EXPORT RESTRICTIONS AND LEVIES.



The software is subject to United States export laws and regulations. You must comply with all
domestic and international export laws and regulations that apply to the licensed device and associated
software. These laws include restrictions on destinations, end users, and end use.

You are responsible for obtaining all required government authorizations to purchase and use the
licensed device and software, including, without limitation, any export or import licenses and foreign
exchange permits. NextEngine shall not be liable if any such authorizations are delayed, denied,
revoked, restricted, or not renewed, and you shall bear all risks and costs associated with such
activities.

If you are importing or exporting the Software outside of the United States, you agree to indemnify
and hold NextEngine harmless from and against any import and export duties or other claims arising
from such importation or exportation. You shall be responsible for payment of all taxes, fees,
assessments, or levies on the software, or arising out of or imposed by reason of this agreement or the
license granted hereunder, except for any tax based on NextEngine's annual net income.

13. SUPPORT SERVICES.



NextEngine provides online and phone support within the first twelve (12) months of the original
purchase of your licensed device and software products from NextEngine.  This support is non-
transferrable and immediately terminated if the licensed device is resold by the original owner. 
Additional support options may be available for purchase from NextEngine.  Contact NextEngine for
additional information.





14. GOVERNMENT END USERS.



The license granted under this License Agreement does not constitute a response by NextEngine to
any request for proposals, bid solicitation or other invitation or offer to contract by any governmental
authority but instead constitutes an offer to enter into a license agreement only upon the terms and
conditions set forth herein. If the United States Government or any other governmental authority shall
seek to acquire the Software and its acquisition of such Software would result in the U.S. Government
or such other governmental authority having rights in any software that are at variance with the terms
and conditions of this License Agreement, NextEngine shall not be bound by any such rights unless it
shall have expressly entered into an amendment of this License Agreement that shall set forth such
rights in accordance with any applicable governmental rules or regulations, including the Federal
Acquisition Regulation and the Defense Federal Acquisition Regulation Supplement. The Software is
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a "commercial item," as that term is defined in 48 C.F.R. 2.101. The contractor/manufacturer is
NextEngine, Inc., 401 Wilshire Boulevard, Ninth Floor, Santa Monica, CA 90401.





15. ENTIRE AGREEMENT.



This agreement (including the warranty below), any addendum or amendment included with the
software, and the terms for supplements, updates, Internet-based services and support services that you
use, are the entire agreement for the software and support services and supersedes all previous and
contemporaneous communications, presentations, quotations, or agreements regarding the subject
matter hereof.



No waiver, alteration, modification, or cancellation of any of the provisions of this license agreement
shall be binding unless made in writing and signed by an authorized officer of NextEngine. 





16. APPLICABLE LAW.



This license agreement is governed by the laws of the State of California without regard to its conflict
of laws principles. You consent to the jurisdiction and venue in the state and federal courts sitting in
Los Angeles, California. 





17. SURVIVAL.



The obligations of confidentiality and indemnification and other restrictions contained in this license
agreement, but not the license to use the software, shall survive the termination of this license
agreement.





18. EQUITABLE RELIEF.



You agree that NextEngine shall be entitled to obtain injunctive relief against you, in addition to any
other remedies to which it may be entitled, to enforce the terms and conditions of this license
agreement and to protect NextEngine's proprietary rights in the software.





19. WAIVER.



No failure or delay on the part of any party in exercising any right or remedy provided in this license
agreement shall operate as a waiver thereof; nor shall any single or partial exercise of or failure to
exercise any such right or remedy preclude any other or further exercise thereof or the exercise of any
other right or remedy under this license agreement.





20. SEVERABILITY.



If any provision of this license agreement is held by a court of competent jurisdiction to be illegal,
invalid or unenforceable, the remaining provisions shall remain in full force and effect.
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21. LEGAL EFFECT.



This agreement describes certain legal rights. You may have other rights under the laws of your state
or country. You may also have rights with respect to the party from whom you acquired the software.
This agreement does not change your rights under the laws of your state or country if the laws of your
state or country do not permit it to do so. 





22. INDEMNIFICATION.



You agree to hold harmless, indemnify, and defend NextEngine, its officers, directors, employees, and
agents, from and against any loss, claim, or damages (including reasonable attorneys' fees) arising out
of or relating to any claim:

that you have encoded, compressed, copied, or transmitted any materials (other than the materials
provided by NextEngine) in connection with the software; that you have used the software in violation
of another party's rights or in violation of any law; that you have misused, allowed to be misused or
modified the software in any manner not expressly permitted by this license agreement; or that any
content added to or incorporated into the software by you infringes any intellectual property rights of
any third party.





23. HEADINGS.



The headings in this license agreement are for purposes of reference only and shall not in any way
limit or affect the meaning or interpretation of any of the terms hereof. 





24. LIMITATION OF LIABILITY.



IN NO EVENT WILL NEXTENGINE BE LIABLE FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, CONSEQUENTIAL OR PUNITIVE DAMAGES, OR ANY DAMAGES RELATED
TO LOSS OF USE, DATA, SOFTWARE, BUSINESS, PROFITS OR GOODWILL, WORK
STOPPAGE, OR ANY OTHER COMMERCIAL DAMAGES OR LOSSES, ARISING IN
CONTRACT, TORT OR OTHERWISE, EVEN IF NEXTENGINE HAS KNOWLEDGE OF THE
POTENTIAL LOSS OR DAMAGE. NEXTENGINE SHALL NOT BE LIABLE FOR DAMAGES,
CLAIMS BY THIRD PARTIES OR ANY OTHER CLAIM FOR ANY CAUSE WHATSOEVER,
REGARDLESS OF THE FORM OF ACTION, ARISING MORE THAN ONE (1) YEAR AFTER
THE DISCOVERY OF THE DEFECT RESULTING IN ANY SUCH DAMAGE. YOU ACCEPT
THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT WITH THE
UNDERSTANDING THAT NEXTENGINE'S LIABILITY IS LIMITED, THE FEES PAYABLE
HEREUNDER HAVE BEEN AND WILL BE CALCULATED ACCORDINGLY, AND THAT YOU
MAY REDUCE YOUR RISK FURTHER BY MAKING APPROPRIATE PROVISION FOR
INSURANCE. YOU FURTHER AGREE TO MITIGATE ALL LOSSES OR DAMAGES. 



NextEngines total liability to you for actual damages for any cause whatsoever will be limited to the
greater of $500 or the amount paid by you for the software that caused such damage.
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This limitation applies to anything related to the software, services, content (including code) on third
party Internet sites, or third party programs; and 

claims for breach of contract, breach of warranty, guarantee or condition, strict liability, negligence, or
other tort to the extent permitted by applicable law. 



It also applies even if repair, replacement or a refund for the software does not fully compensate you
for any losses; or 

the manufacturer or installer, or NextEngine knew or should have known about the possibility of the
damages. 



Some states do not allow the exclusion or limitation of incidental or consequential damages, so the
above limitation or exclusion may not apply to you. They also may not apply to you because your
country may not allow the exclusion or limitation of incidental, consequential or other damages. 





LIMITED WARRANTY 



A. LIMITED WARRANTY.



If you follow the instructions, the software will perform substantially as described in the NextEngine
materials that you receive in or with the software. 





B. TERM OF WARRANTY; WARRANTY RECIPIENT; LENGTH OF ANY IMPLIED
WARRANTIES.



THE LIMITED WARRANTY COVERS THE SOFTWARE FOR 30 DAYS AFTER ACQUIRED BY
THE FIRST USER. If you transfer the software, the remainder of the warranty will apply to the
recipient.



TO THE EXTENT PERMITTED BY LAW, ANY IMPLIED WARRANTIES, GUARANTEES OR
CONDITIONS LAST ONLY DURING THE TERM OF THE LIMITED WARRANTY. Some states
do not allow limitations on how long an implied warranty lasts, so these limitations may not apply to
you. They also might not apply to you because some countries may not allow limitations on how long
an implied warranty, guarantee or condition lasts. 





C. EXCLUSIONS FROM WARRANTY.



This warranty does not cover problems caused by your acts (or failures to act), the acts of others, or
events beyond the reasonable control of the manufacturer or installer, or NextEngine.



D. REMEDY FOR BREACH OF WARRANTY.



NEXTENGINE WILL, AT ITS ELECTION, EITHER (I) REPAIR OR REPLACE THE SOFTWARE
AT NO CHARGE, OR (II) REFUND THE AMOUNT PAID FOR THE PRODUCT, IF ANY.
NEXTENGINE MAY ALSO REPAIR OR REPLACE SUPPLEMENTS, UPDATES, AND
REPLACEMENT SOFTWARE, OR PROVIDE A REFUND OF THE AMOUNT YOU PAID FOR
THEM, IF ANY. THESE ARE YOUR ONLY REMEDIES FOR BREACH OF THE LIMITED
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WARRANTY. 





E. CONSUMER RIGHTS NOT AFFECTED.



YOU MAY HAVE ADDITIONAL CONSUMER RIGHTS UNDER YOUR LOCAL LAWS, WHICH
THIS AGREEMENT CANNOT CHANGE. 





F. WARRANTY PROCEDURES.



Contact NextEngine to find out how to obtain warranty service for the software. For a refund, you
must comply with the NextEngines return policies. 





G. NO OTHER WARRANTIES.



THE LIMITED WARRANTY IS THE ONLY DIRECT WARRANTY FROM NEXTENGINE.
NEXTENGINE GIVES NO OTHER EXPRESS WARRANTIES, GUARANTEES OR
CONDITIONS. WHERE ALLOWED BY YOUR LOCAL LAWS, NEXTENGINE EXCLUDES
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE
AND NON-INFRINGEMENT. If your local laws give you any implied warranties, guarantees or
conditions, despite this exclusion, your remedies are described in the remedy for breach of warranty
clause above, to the extent permitted by your local laws. 





H. LIMITATION OF LIABILITY FOR BREACH OF WARRANTY.



THE LIMITATION OF LIABILITY CLAUSE ABOVE APPLIES TO BREACHES OF THIS
LIMITED WARRANTY. 

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE
OTHER RIGHTS WHICH VARY FROM STATE TO STATE. YOU MAY ALSO HAVE OTHER
RIGHTS WHICH VARY FROM COUNTRY TO COUNTRY.
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9.2  Customer Support
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9.2.1  Scanner Repairs





In Warranty



Scanner Repairs in Warranty:



          1.  AE diagnoses a scanner as repair needed.

          2.  AE Sends Repair Under Warranty email to Returns (returns@nextengine.com) with original
order information (No RMA # needed).  

          3.  Information Needed:  Name, Email, Phone, Shipping Address, Scanner SN and Order #.

          4.  Scott generates RMA # from original order and emails customer shipping instructions with
generated RMA #.

          5.  Customer ships scanner back to us.

          6.  We receive scanner, fix it and ship it back.



          Domestic: We email labels to customer.

          International: We ship labels to customer.



MultiDrive Repair in Warranty:  If found to be broken by AE, issue repair using the same process
as scanner.



AutoDrive Repair in Warranty:  If found to be broken by AE, send replacement.  



PartGripper Repair in Warranty:  If found to be broken by AE, send replacement.





Out Of Warranty



Scanner Repairs out of Warranty:



          1.  AE diagnoses a scanner as repair needed outside of warranty.

          2.  AE provides customer "Repair" PROMO CODE and link to NextEngine Store Page
(https://www.nextengine.com/store).

          3.  Customer places order for Scanner Repair at a flat rate cost of $395.

          4.  AE Sends Out of Warranty Repair email to Returns (returns@nextengine.com) with original
order information (No RMA # needed). 

          *   Information Needed:  Name, Email, Phone, Shipping Address, Scanner SN and Order #.

          5.  Scott generates RMA # from original order and emails customer shipping instructions with
generated RMA #.

          6.  Customer ships scanner back to us.

          7.  We receive scanner, fix it and ship it back.



          Notes:

          *  Scanner repair fee of $395 now includes a 6 month warranty.

          *  Customer pays for Shipping.

          *  Scanner repair only applies to HD Scanners.

          *  Scanner repair applies to original owners only or those who have previously purchased HD
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ProCare ($295).



MultiDrive Repairs out of Warranty:  If found to be broken by AE, issue repair using the same
process as scanner.



AutoDrive / PartGripper:  No repair option, need to purchase new from nextengine.com/store



SD Scanners Repairs: No longer supported for repair, we do not have parts with which to repair
them.
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9.2.2  Scanner Returns





Stopping Returns Documentation



1.  Understand the customers needs and use any utility possible to help them:

      A.  If speed is the issue, you can offer trials of HD PRO and suggestions on how to improve their
work-flow.

      B.  If data quality is the problem, get their data and make all possible improvements.

      C.  If the end goal seems impossible from the software we offer, research other software that may
help them.



2.  Show we are committed to the customer getting a positive result:  

     A.  Engaging the customer and going above and beyond resonates well with them.

     B.  Extension of the 30 days is another sign of good faith and at times can be the difference in a
return (ask me before offering this).

     C.  Offer to have them send in a part, we'll scan it for them and provide the work-flow on how it
was done.



3.  This is a team effort:

     A.  Passing a potential return to another AE provides the customer another voice that may help
him/her understand better.

     B.  Feel free to consult any or all of the AE's with return questions or suggestions on possible
solutions.



4.  Use the phone or GoTo:

     A.  If the customer is struggling with chat or email, call them or set up a GoTo.



5.  Let me know if a return is imminent:

     A.  Once you have exasperated all other options, make sure Nick is aware prior to sending out the
email to "returns@nextengine.com".



6.  Remember our updated return processing policies:

     A.  The returns email should contain ALL pertinent info:  User's Name, Email, Order #, Serial #,
Address, Reason for return, and any other notable information.

     B.  Once return email has been sent, let the customer know that they need to package their scanner
immediately and they are to ship the scanner as soon as they receive their labels.

     C.  After the returns email is sent, Scott will be disabling the users software so they cannot use the
scanner any longer.



Make sure to:



1. Find out what their application is and what software they are using.  What is their end goal?

2. What are their complaints / problems with the scanner?

3. Get a copy of their scan data to work with.

4. Get them on the phone / Go To, show commitment to getting them quality results.
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9.2.3  HD Exchange





SD to HD Exchange Process



Pricing:  

$1995 ($995 for HD Pro, $995 Exchange Fee)

Customer responsible for shipping.

New scanner shipped once SD is received.



Procedure for Completing Exchange:

1. Go to nextengine.com/store.

2. Place an order for ScanStudio HD Pro.

3. When prompted, enter the Serial Number of your scanner (found on the bottom of the scanner).

4. Place the order.  The scanner serial number will let us know that you are interested in the HD
exchange and we will update your order to reflect the $1995 price.

5. After your order is placed, you will be contacted by NextEngine about how to send in your SD
scanner.  This will include an RMA # to be put on the Scanner box being shipped back to
NextEngine.



Additional Information:

http://www.nextengine.com/products/hd-technology#1

http://www.nextengine.com/products/hd-technology#2

http://www.nextengine.com/products/hd-technology#3
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9.2.4  Second Hand Scanners





Policy



Second Hand Scanner Policy



*  New owner does not have to pay $295 to use the product and have software.

*  User can pay $295 (ScanStudio HD ProCare) if they would like support, warranty and software
updates.

*  To purchase ScanStudio HD ProCare, the customer must call front desk to complete the order. 1-
310-883-1888.

*  When the purchase of ScanStudio HD Pro Care is made, place as review item under Wiki User
"Resold Scanners".  Make sure to indicate both the original owner, and the new owner's names for
future reference and transfer the licenses accordingly.

*  If it is an SD Scanner, note that it cannot be repaired, we no longer have parts.

*  Promo Code for Resold Scanners would allow the customer to complete the order without our
assistance. (Currently being considered, but not yet implemented.)





Sample Response



Sample Second Hand Scanner Response



For all second hand scanner purchases a new account will be require for setup. This is done through
the purchase of ScanStudio HD ProCare ($295).



This will then provide your very own account for the NextEngine 3D scanner and also includes:



   * Access to Desktop 3D scanner support, tutorials and video

   * Live chat support from 7am - 7pm PST through our NextWiki

   * Software updates for ScanStudioHD



For SD scanner users, it will include the same features above, except it will provide access to the
ScanStudio CORE software.



To get started, please provide us with the following information



   * Name

   * Email

   * Phone

   * Scanner serial number



Thank you, I look forward to hearing back from you.
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9.2.5  Product Pricing





Pricing



NextEngine Product Pricing



Product: Price (EDU Price): 



3D Scanner HD: $2995 ($2795)

ScanStudio HD Pro: $995 ($895)

ScanStudio Cad Tools: $995 ($895)

RapidWorks: $2995 ($1995)*



3-Year Ext. Warranty: $295**

ScanStudio HD ProCare: $295**

RapidWorks ProCare: Prorated

Repair Fee: $395



AutoDrive: $195

MultiDrive: $995

Black Bases: $10

Extra PartGripper: $55

AutoDrive Extension: $10

Extra Powder Pen: $10

Extra Paint Pens: $15



*Prior purchase of Cad Tools is deducted; typical upgrade is $2995-$995=$2000; typical edu upgrade
is $1995-$895=$1100.

**Must be purchased within 90 days of scanner purchase.



RapidWorks ProCare Pricing:

0 - 90 days: $995

90 days - 1 year: $1490

1 year - 2 years: $1985

2 years - 3 years: $2480

After 3 years: $2975





Shipping Cost



Shipping Rates



Central & South America

Scanner:

         Domestic: $235

         Priority: $265

MultiDrive:
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         Domestic: $105

         Priority: $115



Eastern Europe*, Madagascar, South Africa

Scanner:

         Domestic: $235

         Priority: $300

MultiDrive:

         Domestic: $105

         Priority: $130



Canada & Mexico

Scanner:

         Domestic: $65

         Priority: $85

MultiDrive:

         Domestic: $36

         Priority: $42



*Not Standard Rates:  Albania, Belarus, Boznia-Herzegovima, Bulgaria, Croatia, Czech Republic,
Estonia, Hungary, Latvia, Lithuania, Macedonia, Moldova, Montenegro, Poland, Romania, Serbia,
Slovakia, Slovenia, Ukraine.



Countries not serviced by FedEx:  Andorra, Burma, Central African Republic, Comoros, Cuba,
Equatorial Guinea - GQ, Falklands, Guinea Bissau, Iran, Johnston Island, Kiribati, Myanmar, Nauru,
Niue, North Korea, Sao Tome & Principe, St Helena (S. Atlantic), Sierra Leone, Solomon Islands,
Somalia, Sudan, Tajikistan, Tokelau Island, Republic of Turkmenistan, Tuvalu, Wake Islands, Russia,
Libya
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9.2.6  FTP Protocol





FTP Login



If a customer asks about sample files, direct them to the FTP.



Username: nemedia

Password: nextenginedata4u



Username: sbsamples

Password: statue818



Username: sarahb

Password: user



Username: sarah

Password: snickers



Username: brad

Password: wolverines



Username: andres

Password: porsche



Username: andrest

Password: porsche



Username: nick

Password: baseball



Username: dang

Password: casper



Username: rapidworks

Password: nextengine



Username: inus

Password: re4ne



Username: taylor

Password: corvette



Username: builds

Password: scanstudio2





Ways to Access
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1. Download Filezilla (http://filezilla-project.org/) to upload / download files.

2. Use Web Browser to go to ftp.nextengine.com.

3. Use Folder Viewing Window on computer:



Open My Computer or any folder viewing window:






In the Address bar, type in: ftp.nextengine.com:






Press enter and a window should come up asking for the username and password:






Log on to access the FTP site
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9.2.7  Wiki Account Policies





Internal (Brad, Dan, Sales): 

          Create Prospect account and create action item or notification to delete after trial is over.



External (Resellers, Customers):

          Refer them back to the owner, reseller or supplier for login information.



Multiple Scanners:

          Create new account for scanner only if multiple scanners purchased.
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9.2.8  Common Support Instructions





ScanStudio HD



Quick Reinstall:



          1. Uninstall ScanStudioHD from Windows Start, All Programs, NextEngine, ScanStudioHD,
Uninstall.exe

          2. Delete the C:\Program Files\NextEngine directory

          3. Download ScanStudioHD from www.nextengine.com/start or the NextWiki downloads
section

          4. Install with scanner unplugged



Full Reinstall:



          1. Go to support.nextengine.com to Downloads-> ScanStudio HD.  Download 32 or 64 bit
scanstudio HD 1.3.0 depending on whether you have a 32 or 64 bit OS.  Save to your desktop.



          2. Shut down ScanStudio.



          3. Run the uninstaller in the Start -> Programs -> NextEngine folder.



          4. Delete the following folders:



          C:\Program Data\NextEngine (for Vista/Win 7)

          C:\Documents and Settings\All Users\Application Data\NextEngine (for XP)

          C:\Program Files\NextEngine

          C:\Program Files (x86)\NextEngine

          note: make sure "show hidden folders" is on for the Program Data folder to show up.



          5.  (For Vista or Win 7) Go to Control Panel-> User Accounts.  In the User Accounts, there
should be a window with a small blue link to change/turn off the User Account Controls (UAC). 
Make sure the slider is set down to the lowest level.



          6. Restart your computer.  Make sure antivirus/firewall are down temporarily.



          7. Run the installer from your desktop for the ScanStudio HD 1.3.0 you downloaded with
scanner unplugged. Make sure you install on the computer C: hard drive.





ScanStudio Core



Full Reinstall (XP / Vista)



          1. Uninstall any versions of ScanStudio.



          2. Delete the following folders:
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          C:\Documents and Settings\All Users\Application Data\NextEngine (for XP)

          C:\ProgramData\NextEngine (for vista)

          C:\Program Files\NextEngine



          If those folders are not visible, make sure your folder tools is set to "Show hidden folders".



          3. Go to www.nextengine.com/start and login.



          4. There should be a link that says "To download software for your SD scanner, click here". 
Click this link, download ScanStudio 1.7.3 and install it without the scanner connected.  



          5. After installation, plug scanner and verify that software and scanner work effectively.



Full Reinstall (Windows 7 64 bit ONLY)



          1. Make sure you have the installer for ScanStudio 1.7.3 on your desktop.



          2. Shut down ScanStudio.



          3. Run the uninstaller in the Start -> Programs -> NextEngine folder for all versions that are
installed.



          4. Delete the following folders:



          C:\Program Data\NextEngine (for Vista/Win 7)

          C:\Documents and Settings\All Users\Application Data\NextEngine (for XP)

          C:\Program Files\NextEngine

          C:\Program Files (x86)\NextEngine

          note: make sure "show hidden folders" is on for the Program Data folder to show up.



          5. (For Vista or Win 7) Go to Control Panel-> User Accounts. In the User Accounts, there
should be a window with a small blue link to Change/turn off the User Account Controls (UAC).
Make sure the slider is set down to the lowest level.



          6. Restart your computer. Make sure antivirus/firewall are off temporarily.



          7. Run the installer from your desktop for the ScanStudio 1.7.3 with scanner unplugged. Make
sure you install in the computer's C: hard drive as an administrator. You can right click on the installer
and select "Run as administrator".



          8. Afterwards, use the driver installer on the support.nextengine.com website to install the new
win drivers.  It is in the downloads section. Then, place the previous driver I posted/attached here and
place it in the locations:



          C:\Program Files (x86)\NextEngine\ScanStudio\Driver

          C:\Program Files (x86)\NextEngine\ScanStudio\dll



          (attach driver wdapi901.dll)
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Login Information



Need to Match two out of three of the following in order to disclose login information:



Name, Email, Company

Order Number

Scanner Serial Number



Be sure to check in both the Order System and the Wiki.
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